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About DataMan 9500
The DataMan 9500 reader offers a handheld ID reader supporting an integrated 
user interface based on a mobile computer. It combines the industry’s 
most advanced technology for reading 1-D and 2-D codes using liquid lens 
technology with a programmable WinCE platform.

The enhanced interface allows you to write and implement your own application 
according to your work environment’s needs.

The DataMan 9500 reader 
includes the following features:

•	 an embedded color LCD and 
full function keyboard

•	 an embedded Setup Tool Lite, 
which allows you to view 
acquired and decoded images 
directly on the reader and 
perform reader configuration

•	 several embedded 
programming interfaces that 
you can use to write custom 
applications

•	 support for direct connection 
to an existing corporate or 
factory wireless network

DataMan 9500 Accessories

Charging Base Station 

DMA-CBASE-00

Power Supply for base 
station

DMA-24VPWR-xx

Battery

DMA-HHBATTERY-00
Stylus 

DMA-STYLUS-00

CD-ROM

DMA-SETUPTOOL-421

Quick Reference Guide 
(this document)

590-7146
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Physical Layout of the Reader
LASER LIGHT, DO NOT STARE INTO BEAM
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Overview of Setting Up the Reader
To be able to connect to your reader on your computer, you must perform the 
following steps:

1.	 Insert the battery into the reader and put the end cap on. Power up your 
device by pressing the Power button.

2. Try the default configurations using the Setup Tool Lite on your device.

3. To change settings on the code reader portion of your device, install the 
Setup Tool to your PC. 

 

4. Connect to your device on your PC using wireless communication.

5. Make the necessary settings using the Setup Tool on your PC.

6. Start creating your own application. For more information on how to write 
your own application, see the DataMan 9500 Integration Guide, available 
through the DataMan 9500 Developer Toolset Installer.

1. Insert the battery and put the end cap on.

Powering up your Reader

2. Press the power button on the device.
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DataMan 9500 Wireless Communication
The DataMan 9500 device supports two types of wireless communication: ad 
hoc and access point. 

By default, the device is configured to connect to an ad hoc network, that 
is, it communicates with your PC through a wireless network adapter (for 
example, a wireless USB stick). 

Access point communication means that the DataMan 9500 connects to a 
wireless router, which in turn is connected to a PC through Ethernet. Wireless 
communication is established between the reader and the wireless access point 
(the router).

Ad-Hoc Wireless Communication
Connect your DataMan 9500 to your PC using the following steps:

1.	Press the Power button on the device. The Shutdown menu appears.

2.	Click the Device info... button. The Cognex Device Configuration 
menu appears.

3.	 In the Wi-Fi group box, check the SSID of the device. You have to 
remember the SSID to know which device to connect to.

4.	On your PC, find the adapter settings options through Control 
Panel ―› Network and Internet (only on Windows 7)―› Network 
Connections. 

5.	Right-click the Wireless Network Connection (your wireless device).

6.	Click Properties.

7.	Click the TCP/IPv4 line in the list that appears. 

8.	Click Properties at the bottom.

9.	 In the window that appears, choose the Use the following IP 
address option.

10. Set the IP address to 192.168.99.1. 

11. Click the PC icon on your Windows Desktop toolbar. Your device will     
be listed under Wireless Network Connection.

12. Click your device based on its SSID. 

13. Click the Connect button that appears.

When you hear a short beep on your device, wireless communication is 
established.
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Access Point Wireless Communication
Connect your DataMan 9500 to your access point using the following steps:

1.	Configure your wireless access point so that it recognizes your DataMan 
9500 by adding DM9500-AP to your router.

2.	On your DataMan 9500, using your stylus, click the Start menu icon.

3.	Click Settings ―› Control Panel. 

4.	Double-click the Wi-Fi icon. The Summit Client Utility appears.

5.	 In the Active Profile drop-down list, select Default AP.

6.	Click OK on the upper toolbar for changes to take effect.

NOTE that these settings do not persist through the device rebooting. For the 
changes to be saved, do a Registry Backup, described in the section Backing 
Up your DataMan 9500 of this document.

Your device automatically connects to any access point that is configured this 
way. A short beep on your DataMan 9500 signals that wireless communication 
was established.

Backing Up your DataMan 9500
Unless you save your configuration changes to the Registry Backup, 
all of them are lost when you power off your device. Perform the 
following steps to save your changes:
1.	Click Start menu  ―› Settings ―› Control 

Panel

2.	 In the Control panel, double-click the Cognex 
icon.

3.	Click the Advanced tab.

4.	Click Registry save/reset. The Registry 
Backup page appears. Backup Registry 
is the selected option by default. Click the 
Backup button.
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DataMan 9500 Power Management
Press down the Power button on the device.

The following window appears:

Suspend

The device goes to sleep on demand. 
NOTE that the device also goes to sleep 
automatically after a period of time. To 
configure this period, click the Start 
menu, click Settings, Control Panel, 
Power, and the Schemes tab.

Tap the Suspend button to send the device to sleep. 
Selecting another option changes this button to that 
option.

•	 User Idle Timeout: the time after 
which the screen is dimmed

•	 System Idle Timeout: the time after 
which the screen becomes black

•	 Suspend Timeout: the time after 
which the device goes to sleep

Reboot

The contents in the device’s memory are not erased, but data in any 
running program that you did not save are not preserved. Make sure 
you save all your changed settings before you reboot. 

Alternatively, scan the Reboot configuration code on the back cover of 
this document.

Power off

The device shuts down completely. Power off your device any time you 
do not need it for a long time without charging.
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DataMan 9500 Initial Screen
The operating system of your DM9500 device is an embedded WindowsCE 
system with a number of pre-installed Cognex-specific applications.

When your DM9500 device boots up, the following initial screen appears:

The My Device icon opens an Explorer window 
with the contents of the device’s storage.

The tray contains the following icons:

•	 Network - shows network status
•	 Wi-Fi signal strength
•	 Clock
•	 Virtual keyboard
•	 Task Manager

The Windows Start menu displays the menu 
with the default and pre-installed Cognex-
specific applications.

NOTE: You can write your own application for the DataMan 9500 device. For 
more information on how to write your own application, see the DataMan 9500 
Integration Guide, available through the DataMan 9500 Developer Toolset 
Installer.

Besides Cognex applications, the Summit Client Utility application, also 
available through the Windows Start menu, provides various wireless settings 
options.

Setup Tool Lite Overview
Setup Tool Lite is an interactive user interface for DataMan 9500. It has 
a reduced tool set to configure the imager, read and decode images and 
display live images.

Use the following path to start the Setup Tool Lite: Start menu  ―› 
Programs ―› Cognex ―› Setup Tool Lite.

The application automatically connects to the internal code reader, and 
initializes it if necessary. After initialization, the application window is 
displayed, with the following main parts:

Image display area (optionally 
with detailed read results) 
 
 
 
 
 

Read result panel

Functions toolbar
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For a detailed description of each Setup Tool Lite pane, see the DM9500 
Reference Manual, available through the Windows Start menu.

Setup Tool Lite Overview (Continued)
To quit the Setup Tool Lite, tap the X at the top right corner.

decoded 
image

code 
content

Live Display: 
see what your 
device sees

UltraLight Recipes 
and Settings: 
change lighting 
according to 
different target 
light and surface 
conditions using 
four different 
lighting setups

Load/Save 
Configurations: save 
settings or open 
your previously 
saved settings

Liquid Lens Setup: 
make focus settings 
(focus steps and 
focus range) per 
UltraLight pane

Data Formatting: 
format the output 
of the code 
content

Data Validation: check 
your code content 
against a pre-defined full 
string or pattern

FTP Settings: 
configure the 
FTP server you 
want to send 
images to

Advanced operations: 
send DataMan Control 
Commands (DMCC)

Symbology Settings: 
enable and disable 
symbologies

History: view history of 
decoded code content 
and time stamp
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Setup Tool Lite Read Result Panel
The Read result panel is placed under the 
image, and shows the code last read. If reading 
is unsuccessful, no code is displayed here.

Tap this result panel or the History button 
and the History page with the reading history 
appears.

Inventory Demo Application Overview
The purpose of this demo application is to give a basic example about 
using the DataMan 9500 device for Inventory purposes in an imaginary 
warehouse. The application shows the following features:

•	 Reading product ID codes, displaying 
them on the handheld screen, 
together with the image seen. 

•	 Matching product codes with a 
detailed product database residing 
either on the device or on a remote 
company server. 

•	 Displaying the matching product 
data, together with product images 
from the database. 

•	 Allowing you to modify the product 
information and/or the stock data on 
the device.

When started, the application automatically connects to the internal 
product database (stored on the device), and also to the code reader.

On your DataMan 9500, click the Start menu  ―› Programs ―› Cognex 
―› Inventory Demo.
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OR

•	 through a PC connection: in this mode, the Inventory Demo on your 
DataMan 9500 receives and displays product data and images sent from 
the PC-side product database, with the help of the PC-based DataMan 
Demonstrator application. Install the DataMan Demonstrator through the 
DM9500 Developer Toolset installer.

Inventory Demo Application Overview (Continued)

For more information on how to use the Inventory Demo and the 
DataMan Demonstrator, see the DM9500 Reference Manual.

NOTE: For Ad-Hoc wireless connections, check your firewall status for 
the database connection, as images from the database may be blocked 
by the firewall.

The Inventory Demo application runs

•	 in standalone mode: displaying the read images and codes on your DataMan 
9500
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Install DataMan 9500 Software
1.	Check the DataMan Release Notes for a full list of system requirements. 

2.	 Insert the CD-ROM and follow the on-screen instructions.

3.	Connect the DataMan 9500 to your PC through Wi-Fi as described in the 
DataMan 9500 Wireless Communication section of this document.

4.	 Launch the Setup Tool and click Refresh. The reader appears under 
Network devices.

5.	Select a Network devices listing and click Connect. 

Wireless connection
“DM9500” with the last 6 
characters of MAC address, 
printed on back of the reader. 

Troubleshooting a Wireless Connection
Based on your network configuration, the Setup Tool may not be able 
to communicate with the reader and it will not appear in the list of 
Network devices. 

First check the wireless connection with the reader and click Refresh 
in the Setup Tool. Next, if you are using an ad hoc network connection, 
disconnect from the reader and connect again. If you are using an 
access point network connection, reboot your access point device.

If the reader still does not appear, you can use the Add Device option 
in the Setup Tool. 

If all of the above fail, remove the battery from the device, insert it 
again, and start up your reader.
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Start the PC Setup Tool
Connect the reader to the Setup Tool to 
configure it with the type of symbologies 
it will decode as well as other parameters, 
such as the type of trigger it will use and the 
format of the results it will generate.

Alternatively, configure your reader 
by scanning the appropriate reader 
configuration code from the Reader 
Configuration Codes document, available 
through the Windows Start menu.

Trigger button

Read history

Quick Setup

Configure your reader in a few basic steps

Connect to Reader
Establish a connection to the reader

Results Display
View results

UltraLight Settings
Choose a trigger type and other acquisition 
parameters

System Settings
Configure visual and audio feedback, trigger 
and output actions

Latest image Context based help

Connection status/Signal 
strengthBattery level indicator 
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Use the Setup Tool Menu Bar
Each reader can store its current set of runtime parameters to a configuration 
(.cfg) file, which contains information such as the enabled symbologies and 
how any output data should be formatted. 

The same configuration file can be loaded onto multiple readers, as the file 
does not contain identification information such as the IP address or device 
name of the reader used to create it.

A reader can also generate a Cognex device configuration (.cdc) file, which 
stores the set of runtime parameters plus any identification data, such as 
the name of the device, its IP address, subnet mask, and so on. Cognex 
recommends generating a device configuration file for each reader to allow you 
to restore a reader to its operating state with minimal effort. 

Use the File menu of the Setup Tool to manage .cfg and .cdc files: 

File Menu

Open Configuration Open a saved .cfg configuration file. 

Save Configuration Create a .cfg configuration file of current runtime 
parameters. 

Print Configuration Code Generate a programming codes sheet 
representing your reader’s configuration.

Restore Device Load a saved device configuration .cdc file, 
with runtime parameters plus device-specific 
information for a particular DataMan device. 

Backup Device Create a device configuration .cdc file for a 
specific reader. 

Save Image Save the latest acquired image with .jpg file 
format.

Use the Edit menu for standard Cut, Copy and Paste operations. 

Use the View menu to view reader information (serial number, firmware 
version, and so on) and to enable and disable various elements of the 
Setup Tool, and the Tasks menu to switch between various Setup Tool 
options. 

Use the System menu to manage the current settings on the reader 
and to upgrade the features it currently supports: 

System Menu

Save Settings Save the current parameters to non-volatile 
memory, which allows the reader to restore 
these settings each time you reboot it.

Reset Configuration Reset all configuration parameters in RAM 
(volatile memory) to the default settings 
except for communication settings.

Update Firmware Update the reader software.

Upload Feature Key Unlock additional features available in the 
reader software if you have the right key.

Use the Help menu to display Setup Tool version information. 

NOTE that the Setup Tool does not allow you to update firmware if 
the battery is less than 30% charged. It is therefore recommended to 
place your device on the base station for charging before you update 
firmware.
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Keyboard Emulation
Keyboard Emulation allows a text editor on your DataMan 9500 to display code 
content as if it was typed on your DataMan 9500 keyboard. 

To enable keyboard emulation, perform the following steps:

1.	Scan the Mobile Computer Keyboard Emulation Enable Configuration Code 
(from the Reader Configuration Codes document, available through the 
Windows Start menu.)

2.	Open a text editor on your DataMan 9500, for example, Microsoft WordPad, 
and place your cursor into an empty document.

3.	See that scanned codes appear as newly typed text in the document.

Calibrating your Screen
Your device starts up showing the initial screen with a factory 
calibration. If the screen does not respond to your taps, recalibrate your 
screen by performing the following steps:

1.	Click Start menu  ―› Settings ―› Control Panel

2.	Double click the Stylus icon. The Stylus Properties pane appears.

3.	Switch to the Calibration tab to recalibrate your screen.
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Triggering

After triggering, the last read image is 
displayed at the center of the screen 
in either the Setup Tool or the Setup 
Tool Lite (or both).

The application also indicates 
successful reads with green borders.

The read – and possibly formatted – 
code is displayed under the image.

You can trigger the imager by pulling 
its trigger button or (only when you 
run Setup Tool Lite) by pressing the 
yellow barcode button on the top of 
the device.

Trigger will be ON either until you 
release the button or until the device 
can successfully read a code.

Trigger Types
The DataMan 9500 trigger mode determines when the reader 
attempts to read a code. Use the Setup Tool, or the appropriate reader 
configuration codes, to change trigger types. 

The following trigger types are supported:

•	 Presentation: The laser aimer is always on. When motion is detected 
in front of the reader, the reader will turn on and scan for a symbol. 
The reader relies on an internal timing mechanism to acquire images.

•	 Manual (default): Begins acquiring images when you press the trigger 
button on the reader, and continues acquiring images until a symbol 
is found and decoded or you release the button. 
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Data Buffering
When you are within the wireless range or your access point, your reader sends 
decoded data to your PC through the access point, which may be a router or 
your PC. You can also see the decoded images in the Setup Tool, if it is running 
and connected to the reader.

When you leave the wireless range, however, you lose connection to your 
access point, but you can still keep reading codes. The decoded data is saved 
in the buffer of the reader. 

This buffered data appears on your PC again when you come back within the 
wireless range. 

While you are still within the wireless range, the reader occasionally blinks blue 
to indicate that the wireless connection is established.

status indicator blinks magenta: 
your reader is offline

When the reader is offline, good reads are indicated with 2 short beeps and the 
selected good read status indicator color (green by deafult).

status indicator beeps 
twice: your reader is offline 
while decoding symbols

when the buffer is full, the 
reader beeps and the status 
indicator becomes white

When you leave the wireless range, you can still keep reading codes. The 
reader going offline is indicated by a long beep and the status indicator flashes 
magenta. When the buffer is full, no more codes are read. The reader does not 

discard the oldest read. 
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Charging
You can check the status of the battery in the Setup Tool:

or on the DataMan 9500, by clicking the Start menu  ―› Settings ―› Control 
Panel ―› Power.

blinking red status indicator 
indicates low battery

Blinking red status indicators will indicate low battery. As the battery 
discharges, the blink frequency increases.

Place the reader on the base station for charging. Make sure that the 
reader is correctly placed into the slot. 

Charging starts when the device is turned on. If you previously powered 
off your device, it automatically turns on if you place it on the base 
station for charging. In case it does not turn on, turn it on manually.

When the reader is 
charging, the reader’s 
status indicator will be 
red. 

When the status 
indicator turns orange, it 
means that the battery is 
almost fully charged.

When the status 
indicator turns green, the 
battery is fully charged.
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2. Hold the reader in an upright 
position and the battery will slide out 
of the handle. NOTE that you may 
need to shake the reader slightly.

To change batteries, perform the following steps:

Changing Batteries

1. Twist the reader’s end cap, and 
take it off.

The battery should not be disposed of along with municipal 
waste. Use the appropriate separate take-back systems for bat-
tery disposal.

Make sure the 
triangle aligns with 
the circle when the 
cover is locked.

4. Put the end cap back on and twist it.

3. Put the replacement battery into the slot. The battery has a small 
triangle on one of its side. Make sure you insert the battery triangle end 
first.
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When you are charging the auxilliary battery, the base station’s spare battery 
status indicator displays either charging in progress (red) or fully charged 
(green).

5. Place the battery in the spare battery charger in the direction of the small 
triangle of the battery.

Changing Batteries (Continued) Field of View and Reading Distances
There is a range of reading distances available for different code sizes 
and focus positions. Select a focus position that allows you to read the 
desired code sizes at the desired working distance.

•	 If your application has a consistent reading range, set the focus 
range to a limited depth of field with no steps (for example, set it to 
20) or with limited steps (for example, set it to 2 steps between 0 
and 30). This way you can achieve fast performance.

•	 If your application has a variety of code types and sizes, set the 
focus range to a wider depth of field with increased number of steps 
(for example, set it to 6 steps between 0 and 200). This way you can 
get better coverage.

For a map of the field of view and reading distances, see the next page.
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Map of Field of View and Reading Distances
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Weight 525 g

Operating Temperature 0ºC — 40ºC (32ºF — 104ºF)

Storage Temperature -40ºC — 60ºC (-40ºF — 140ºF)

Maximum Humidity 95% (non-condensing)

Codes Data MatrixTM; QR Code and microQR Code; UPC/EAN/JAN; 
Codabar, Interleaved 2 of 5, Code 39, Code 128, and Code 

93, Pharma, Postal, RSS/CS, PDF 417, MicroPDF 417

Power Supply
Requirements

Li-Ion battery with at least 2000mAh capacity
+24 V power supply for the base station

Expected operating time 
for typical scan batches  
(400 scan per hour) with 
a fully charged battery

5 hours

Wireless protocol 802.11 a/b/g

Access point require-
ments

CCx4 standard support, access point should be within 
30 meters

DataMan 9500 Specifications Laser Information
LASER LIGHT, DO NOT STARE INTO BEAM: CLASS 2 LASER PRODUCT

FAILURE TO FOLLOW THESE INSTRUCTIONS MAY CAUSE SERIOUS 
INJURY

•	 CAUTION: Use of controls or adjustments or performance of 
procedures other than those specified herein may result in hazardous 
radiation exposure.  

•	 Do not attempt to service or repair this product -- return it to Cognex 
for service.  

•	 Do not permit anyone other than Cognex Corporation to service, 
repair, or adjust this product. 

•	 Do not attempt to open or modify this device except as described in 
this document.

•	 Do not direct or reflect laser light toward people or reflective objects. 
•	 Do not operate this device if it is damaged or if the covers or seals 

are missing or damaged. 

This Laser Product is designated as Class 2 during all procedures of 
operation.

Wavelength 650 nm

Laser Power for classification < 1 mW

Beam Diameter < 3mm at aperture

Divergence < 5 mrad

For assistance contact Cognex Corporation at http://support.cognex.com



46  DataMan 9500 Quick Reference Guide DataMan 9500 Quick Reference Guide   47

The DataMan 9500 series meets or exceeds the requirements of all applicable standards 
organizations for safe operation. However, as with any electrical equipment, the best way 
to ensure safe operation is to operate them according to the agency guidelines that follow. 
Please read these guidelines carefully before using your device.
Regulator Specification
USA FCC Part 15B, Class A

FCC Part 15.247
FCC Part 15.407
FDA/CDRH Laser Notice No 50

Canada ICES-003
RSS 210

European Community EN301 489-1 / -17
EN300 328-2
EN60950
EN60825-1

Japan J55022, Class A

Agency Compliance Statements

FCC Class A Compliance Statement
This equipment has been tested and found to comply with the limits for a Class
A digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. 
This equipment generates, uses, and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instruction manual, may cause harmful interfer-
ence to radio communications. Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the interfer-
ence at his own expense.

This device complies with Part 15 of the FCC Rules and with RSS-210 of Industry Canada. 

Operation is subject to the following two conditions: 
(1)	 this device may not cause harmful interference, and 
(2)	 this device must accept any interference received, including interference that 

Canadian Compliance
This Class A digital apparatus complies with Canadian ICES-003. 
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 
Canada. 

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux ap-
pareils radio exempts de licence. L’exploitation est autorisée aux deux conditions 
suivantes : (1) l’appareil ne doit pas produire de brouillage, et (2) l’utilisateur de 
l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage 
est susceptible d’en compromettre le fonctionnement.

Cofetel Notice
La operación de este equipo está sujeta a las siguientes dos condiciones:
(1) es posible que este equipo o dispositivo no cause interferencia perjudicial y (2) 
este equipo o dispositivo debe aceptar cualquier interferencia, incluyendo la que 
pueda causar su operación no deseada.

European Compliance

   
This equipment complies with the essential requirements of EU Directives 1999/5/
EC, 2004/108/EC and 2006/95/EC, as applicable. Declarations are available from 

may cause undesired operation. 

Changes or modifications made to this equipment not expressly approved by Cog-
nex may void the FCC authorization to operate this equipment.
Radiofrequency radiation exposure information:
For body worn operation, this device has been tested and meets the FCC RF expo-
sure guidelines when worn in hand or close to the body with the holster.
Use of any accessory, especially  that contain any metal, may not ensure compli-
ance with FCC RF exposure guidelines. (the holster will be available as an acces-
sory in Q3 2012)
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your local representative. 
Където е приложимо, оборудването е съобразено с основните изисквания 
наЕвропейските директиви 1999/5/ЕС, 2004/108/ЕС и 2006/95/ЕС. Декларации са 
налични от местния представител. 
Toto zařízení splňuje základní požadavky směrnic EU 1999/5/ES, 2004/108/ES a 2006/95/
ES, vždy dle konkrétního způsobu použití. Příslušná prohlášení jsou k dispozici u vašeho 
lokálního distributora. 
Dette udstyr overholder de væsentlige krav i EU-direktiv 1999/5/EF, 2004/108/EF og 
2006/95/EF, som er relevant. Erklæringerne kan fås hos din lokale repræsentant. 
Tämä laitteisto täyttää seuraavat EU Direktiivien olennaiset vaatimukset 1999/5/EY, 
2004/108/EY ja 2006/95/EY, soveltuen. Vaatimusten-mukaisuusvakuutukset ovat saata-
villa paikalliselta edustajalta. 
Dit produkt voldoet aan de voorschriften van de richtlijnen van de EG Raad (1999/5/EC, 
2004/108/EC en 2006/95/EC), indien van toepassing. Declaraties zijn beschikbaar bij uw 
locale vertegenwoordiger. 
Cet appareil est conforme aux exigences essentielles des Directives  de l’Union Europée-
nne 1999/5/CE, 2004/108/CE et/ou 2006/95/CE. Veuillez consulter votre représentant 
local pour les déclarations applicables.                                                               
Ezen készülék technikai jellemzői megfelelnek a vonatkozó 1999/5/ EC, 2004/108/EC és 
2006/95/EC EU rendeletekben foglalt követelményeknek. A megfelelőségi dokumentáció a 
gyártó helyi partnereinél áll az Ön rendelkezésére. 
Questo prodotto,ove applicabile, risponde alle direttive Europee 1999/5/EC, 2004/108/EC 
e 2006/95/EC. Dichiarazioni sono disponibili presso il vostro rappresentante locale. 
Ten sprzęt jest zgodny z ogólnymi wymaganiami Dyrektyw UE nr 1999/5/EC, 2004/108/
EC i 2006/95/EC, na ile znajdują zastosow-anie. Oświadczenia są dostępne u lokalnych 
przedstawicieli. 
Acest echipament este in conformitate cu cerintele esentiale ale Directivelor EU 1999/5/
EC, 2004/108/EC si 2006/95/EC. Certifi-catele sunt disponibile la reprezentanta lo-
cala. Toto zariadenie spĺňa základné požiadavky smerníc EÚ 1999/5/ES,2004/108/ES a 
2006/95/ES, vždy podľa konkrétneho spôsobu použitia. Príslušné vyhlásenia sú k dispozícii 
u vášho lokálneho dis-tributora. 
Das Gerät erfüllt die wesentlichen Anforderungen der EU-Direktiven 1999/5/EC, 2004/108/
EC und 2006/95/EC, soweit anwendbar. Eine entsprechende Bescheinigung kann bei Ihrem 
zuständigen Vertriebspartner angefordert werden. 

Agency Compliance Statements (Continued)
Ta oprema je skladna in izpolnjuje nujne zahteve direktiv EU 1999/5/ES, 
2004/108/ES in 2006/95/ES. Deklaracije so na voljo pri vašemkrajevnem pred-
stavniku. 
Αυτός ο εξοπλισμός συμμορφώνεται με τις βασικές απαιτήσεις των εφαρμοσμένων 
οδηγιών 1999/5/EC, 2004/108/EC kai 2006/95/ECτης Ευρωπαικής Ένωσης. Οι 
επίσημες δηλώσεις είναι διαθέσιμες από τον τοπικό σας αντιπρόσωπο. 
Dan l-apparat huwa konformi mar-regolamenti stipulati mid-Direttivi Ewropej 
1999/5/EC, 2004/108/EC u 2006/95/EC skond kif inhu likabbli. Kopji ta’ dawn id-
dikjarazjonijiet huma aċċessibbli mingħand ir-rappreżentant locali tiegħek. 
Este equipo cumple com las condiçãos vigorantes de la EU diretivas 1999/5/EC, 
2004/108/EC e 2006/95/EC, com é pertinente. Las normativas estão disponível 
com su representado local. 
Este equipo cumple con los requerimientos esenciales de las direc-tivas de la EU 
1999/5/EC, 2004/108/EC y 2006/95/EC, si es aplica-ble. Dichas declaraciones 
están en poder de sus representanteslocales. 
Ši iranga atitinka esminius ES direktyvu 1999/5/EC, 2004/108/EC ir 2006/95/EC 
reikalavimus. Deklaracijas galima gauti iš Jusu vietinio atstovo. 
Šis iekartas atbilst ES direktivu 1999/5/EC, 2004/108/EC un 2006/95/EC prasi-
bam. Deklaracijas ir pieejamas regionalajasparstavniecibas. See seadmed vastavad 
olulistele nõuetele ELi direktiivide 1999/5/EC, 2004/108/EC ja 2006/95/EC, mida 
kohaldatakse. Deklarat-sioonid on saadaval Teie kohaliku esindaja. 

Laser Safety Statement

 
Complies with FDA performance standards for laser products except for deviations 
pursuant to Laser Notice No. 50, dated June 24, 2007.

This device has been tested in accordance with IEC60825-1 2nd ed., and has been 
certified to be under the limits of a Class 2 Laser device. 
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For European Union Users

Cognex complies with Directive 2002/96/EC OF THE EUROPEAN PARLIAMENT AND OF THE 
COUNCIL of 27 January 2003 on waste electrical and electronic equipment (WEEE).

This product has required the extraction and use of natural resources for its production. It 
may contain hazardous substances that could impact health and the environment, if not 
properly disposed. 

In order to avoid the dissemination of those substances in our environment and to di-
minish the pressure on the natural resources, we encourage you to use the appropriate 
take-back systems for product disposal. Those systems will reuse or recycle most of the 
materials of the product you are disposing in a sound way.

The crossed out wheeled bin symbol informs you that the product should not be disposed 
of along with municipal waste and invites you to use the appropriate separate take-back 
systems for product disposal.

If you need more information on the collection, reuse, and recycling systems, please con-
tact your local or regional waste administration.

You may also contact your supplier for more information on the environmental perfor-
mance of this product.

Agency Compliance Statements (Continued)



Reader Control Codes

Reset Scanner to 
Factory Defaults

Reboot 
Scanner

P/N 590-7146

Copyright © 2012 Cognex Corporation All Rights Reserved. This document may not be 
copied in whole or in part, nor transferred to any other media or language, without the 
written permission of Cognex Corporation. The hardware and portions of the software 
described in this document may be covered by one or more of the U.S. patents listed 
on the Cognex web site http://www.cognex.com/patents.asp. Other U.S. and foreign 
patents are pending. Cognex, the Cognex logo, UltraLight and DataMan are trade-

marks, or registered trademarks, of Cognex Corporation. 

Reset Scanner to 
Factory Defaults Reboot Scanner


